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Introduction
The Active Circle File Explorer offers features to manage the files stored in Active Circle. The
File Explorer allows you to browse the hierarchical organization of files and folders, in a way
similar to regular file explorers. You can extract files and folders to your local system, view
the version history of files stored in the system, restore earlier versions of files, and manage
security settings on files and folders. In addition, you can initiate archiving processes from
within the File Explorer.

This manual is divided into the following chapters:

Getting Started Describes connecting to the Active Circle File Explorer
and the main features of the interface.

File Information Describes the information about files and directories
available in the Active Circle File Explorer.

Managing Files Describes the actions you can perform on objects in the
File Explorer, such as copying files out of the Active
Circle storage system.

Managing File Versions Describes the version management functionality of the
File Explorer, such as how to restore an earlier version
of a file and how to purge file versions that are no longer
required.

File Security Describes how to view and manage file permissions
(ACLs) using the File Explorer.

Archiving Files Describes the archiving functionality available in the File
Explorer.
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Chapter 1. Getting Started
Figure 1.1. The Active Circle File Explorer

Starting the File Explorer
The File Explorer can be started either directly on a Node or from any machine with a web
browser that supports Java Web Start. Because of this, Active Circle system administrators
can assign users the rights perform certain file management tasks, such as archiving files or
restoring earlier versions of files stored in the system.

Starting the File Explorer on a Node
You can start the File Explorer from one of the Nodes in your Circle by executing the following
script:

/activecircle/admin/bin/explorer &

Starting the File Explorer From a Web Browser
In order to run the Active Circle File Explorer using a web browser, enter either the name or
IP address of one of the Nodes in the address bar:

• http://server-name

• http://IP-address

The following web page will appear:
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Figure 1.2. Active Circle Web Page

Click on the link labelled File Explorer to launch the application download. The File Explorer
can be run on any machine running Java Web Start.

Logging In
The File Explorer interface is the same regardless of where you start it from. By default, it
displays the names of the nodes in the circle in the area to the left in the application. To
access a Share, click on one of the nodes. The login dialog box will be displayed. Enter your
user name and password in the fields and click OK.

Figure 1.3. File Explorer Login

Note

The connection information provided during login will be used for connecting to
the other nodes.
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Once you have logged in, the tree structure under the selected node appears and becomes
navigable. Only the shares (and the associated nodes) that the user has access to will be
displayed. For an administrator, all the shares in the Circle would normally be displayed.

Important

While any Active Circle user with a regular User profile can log in to the File
Explorer, the actions the user is allowed to perform depend on the access
rights and user privileges that have been assigned to the user account. For
regular users lacking specific share access rights, some of the menu items are
unavailable (greyed out) on the context menu which is displayed when right-
clicking on a file or folder object in the explorer tree view.

General Layout

Figure 1.4. File Explorer Interface Layout

The Active Circle File Explorer interface is divided into four main areas:

Menu Bar Located at the top of the File Explorer application
window. It contains the File, View and Tools menus:

– File Menu With the File menu you can:
• Log in
• Log out
• Exit the application

– Edit Menu With the Edit menu you can perform several tasks
which are also available by right-clicking on a selection
or an object in the Explorer views:
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• Copy Selection...
• Show tape list
• Archive...
• Export...
• Security
• Compute MD5 signature
• Data Management: Remove disk copies or copy

files to the cache

– View Menu With the View menu you can:
• Choose to display the Status Bar
• Browse Folders Only if you want the tree structure

to load faster when the directories contain a huge
number of files

• Toggle the display of the Version Search tools
• Refresh the data displayed in the application

– Tools Menu With the Tools menu you can:
• Select a Share to log in to

Version Search Criteria Located under the menu bar of the File Explorer
application window. The tools in this area allow you
to filter the views in the panes below according to
when the file versions were created. You can toggle
the display of this box on and off using the View menu.
For more information, see Chapter 4, Managing File
Versions.

Navigation Pane Located on the left-hand side of the application
window, the Navigation Pane displays the nodes,
shares, folders, and files as a navigable tree structure
like in a conventional file explorer.

Information Pane Located on the right-hand side of the application
window, the Information Pane displays the available
information for the object currently selected in
the Navigation Pane. For more information, see
Chapter 2, File Information

The Information Pane can contain these buttons:

Select Columns This button opens the Select Columns dialog box
allowing you to determine which columns will be
visible in the interface by selecting the corresponding
check boxes. For more information, see “Select
Columns”

Data Location Opens the Data Location dialog. For more
information, see “Data Location”

Security Opens the Security dialog. For more information,
see “Security Settings”
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Chapter 2. File Information
This chapter describes the types of information that the Active Circle File Explorer displays
about shares, directories and files.

When the File Explorer is started, it displays the list of nodes configured in the circle. Clicking
on a node in the navigation pane will display a list of the shares that are activated on the node.

Figure 2.1. List of Shares on a Selected Node

If you double-click on a node, the list of shares will also be displayed below the node in the
navigation pane. You can then click on the shares and the plus signs next to them to expand
the view into a tree structure of directories and files. The display in the information pane on
the right will show the available information for the element selected in the navigation pane
to the left.

Share and Directory Information
When you click on a share or a folder in the tree view, the right pane will show summary file
and archiving information for the share or folder, above the list of directories or files. The total
number of files and the total volume of the files are displayed, as well as the number of files
and folders that have not been archived on each pool the share is associated with. If more
than one location (pool) has been defined in the archiving policy for the share, one line will
be shown for each location (up to four).

Figure 2.2. Share or Directory Summary
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When you select a folder in the navigation pane, the information pane will display two types
of information about the folder:

• The list of files contained in the folder
• The list of versions for the folder itself

Figure 2.3. Directory Information

In both views you can click the Select Columns button to choose which data colums should
be displayed for each object.

File Information
When you select a file in the tree view in the navigation pane, all the versions of the file will
be displayed in the information pane to the right.

Figure 2.4. File Versions



Chapter 2. File Information

Explorer Guide 7

For each file version, several types of information is displayed:

• Version information
• Information about size, author and attributes
• Creation, access and modification dates
• Archiving status
• Storage policy status
• Unix file mode
• User and group ID for NFS
• Link information
• MD5 checksum information
• Integrity check information

Figure 2.5. Example of file information

Select Columns

You control which data columns will be displayed by clicking on the Select Columns button.

Figure 2.6. Data Columns Selection

Data Location
Using the Data Location feature, you can identify where in the Active Circle system the data
corresponding to any particular file is stored. This functionality is also useful for verifying if
a particular file has been archived.
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The Data Location window can be accessed by right-clicking on a file in either the left-hand
or the right-hand pane and selecting Display Data Location from the context menu, or by
clicking on the Data Location button in the Information pane.

Figure 2.7. Viewing the data location

The Data Location dialog box displays where the file data is stored: the cache, pool and
node, the partition on the node, down to the level of the box pack file (the mechanism used by
the Active Circle system for storing data). If a copy of the file has been archived, information
relating to its location on tape will be displayed.
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Figure 2.8. Data Location dialog

The above example shows a file that has a copy in all possible location types at the same
time (cache, disk, tape). If the file only existed on tape, the top part of the dialog would be
empty (and vice versa if the file only existed on disk). The Accessibility status of the file is
indicated. The following table shows what the status means for the availability of the files.

Table 2.1. Accessibility and File availability

Accessibility Location type File Availability

Online Cache/Disk Automatic

Nearline Tape archive Automatic

Offline Tape archive Operator intervention required

On Cloud Cloud archive Automatic

Cloud Archive Locations
The Data Location feature can also display information about data stored in the cloud. The
cloud location information is displayed in the lower part of the Data Location dialog, as cloud
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data are by definition archived. Since a file in the cloud may also exist in a local disk pool (if
a storage policy has been defined for the share), location information for the same file can
also be displayed in the upper (local) part of the location dialog. However, only the lower part
refers to the actual cloud storage. If you have selected a file which belongs to a cloud pool,
and no cloud information is shown in the archive area of the Data Location dialog, it means
that the data in the pool have not been archived yet or that an archiving operation has failed.
You could also check if the Active Circle share you are archiving from has an archiving policy
associated with the cloud pool, using the Active Circle Administration Tool.

Figure 2.9. Data Location for Cloud archives

The location information for the cloud data refers to the share name and archive sequence
number, the cloud pool and the archive identifier. Since the cloud data storage is defined as a
single unlimited partition, there is no tape or other physical location information available. The
On Cloud accessibility status indicates that the cloud is connected and the data available.

In the event a problem occurs in the cloud or with the connection to the cloud, the Data
Location dialog will indicate that the "information is not available" instead of showing the
accessibility. The share, archive number and pool name will still be indicated, as shown
below. In this case you should check the network or contact your administrator or cloud
provider.
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Figure 2.10. Data Location for Cloud archives without connection

Tape Locations
You can use the Active Circle File Explorer to find out on which tape(s) a selection of files
have been archived on. This information could be useful in preparation for certain tasks, for
example to to verify the set of tapes necessary so that the administrator can check if those
tapes are located in the tape library. You can request the list of tapes for a selection of files,
folders or an entire share.

The Tape Locations window can be accessed by right-clicking on a file, a file selection, a
folder or a share in the tree view and selecting Show tape list from the context menu.

Figure 2.11. Show tape list menu item

If you select only one file, the Tape Locations dialog will be displayed right away, if that file
has been archived to tape. If more than one file or a directory was selected, the list of files
to find tape locations for is displayed:



Chapter 2. File Information

12 Explorer Guide

Figure 2.12. Selected files

Click on OK to obtain the tape information. The Tape locations dialog will be displayed. It
shows the list of all the tapes where the selected files have been archived. If multiple copies
of the files exist on tape, you can choose the tape pool to use for displaying the list of tapes.

Figure 2.13. Tape Locations
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Chapter 3. Managing Files
This chapter describes the file management tasks you can perform in the Active Circle File
Explorer:

• Make a local copy of files stored in the Active Circle system
• Purge files from the system using the Delete feature
• Remove copies of files on disk
• Create copies of files on disk
• Copy files to the cache (destaging)

Your ability to perform these tasks depends on your access rights as defined in your
user profile. Please contact your system administrator if you have problems accessing this
functionality.

Making a Local Copy
Using the Active Circle File Explorer, it is possible to extract a file, the contents of a directory,
or an entire directory structure from an Active Circle share, and copy it to your local system.

Note

You need to have the profile Restore operator associated with your user
account or be a Data administrator to perform this operation.

Important

If the system discovers that one or more of the objects you want to extract are
located on an offline tape, you will be notified about this, and given options to
proceed. Be aware that extracting offline files will require the intervention of an
operator on a tape library, which involves additional processing time. This case is
described in the section about offline file retrieval below.

Right-click on the object you want to extract and select Copy Selection.

Figure 3.1. Menu Choice for Extracting Local Copies
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The system will begin collecting information about the selected data, and a window is
displayed to inform you of the progress. If you selected a large number of files and directories,
this process can take some time. If few files were selected, the progress window may be
displayed for less than a second.

Figure 3.2. File Information Retrieval Progress

A dialog box will open to allow you to browse to the location where you want to copy the
selected item.

Figure 3.3. Browse to Select the Destination Directory

If the destination folder is not empty, you will be shown a window where you have to choose
between three options:
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Figure 3.4. Select Option for Existing Files

Skip file Only files that do not already exist will be copied.
Overwrite exisiting file Copies all the files, replacing the files that already

exist.
Rename file Copies all the files, but renames any files which

already exist (a number is added to the file name of
the newly copied file).

Click OK to proceed. An information message will be displayed before the copy operation
starts, showing the list of files to be copied and giving you an option to use the full path of
the files:

Figure 3.5. Information for Copying One or More Files

Click on Create directory structure up to the root of the share if you want the full path
of the file to be re-created on the destination. Click OK to copy the files to the selected
destination. You can also click Cancel to end the operation.
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Note

When copying the files, the Active Circle File Explorer recreates the entire
directory structure for the copied files up to but not including the root of the
Share, regardless of what level in the folder structure you copy.

If you decide to proceed with the copy operation, the system will now perform an analysis
of the files you selected for extract. If all the files you selected for copying are available
(meaning the Acessibility status is either Online or Nearline as indicated by the Data
Location feature), the copying process starts immediately. In this case, you may skip the next
section and proceed to the copy progress and completion section.

If the file analysis finds that one or more of the files you selected are not available
for automatic retrieval because their accessibility status is Offline, you need to perform
additional steps before the copying process can start. These options are described in the
next section.

Copying Files from Offline Media
When the status of a file is Offline, it means that it is located in an archive on a tape which has
been removed from the tape library. Consequently, any data retrieval from the tape would
require the action by an operator to load the tape into the library. If you have selected to copy
offline files, a dialog will be displayed informing you of your options.

Figure 3.6. Offline File Information and Options

The information window displays a list of the offline files. Below that, the options are
described:
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Continue and Wait If there are any Online or Nearline files in your selection,
the copying of these will begin immediately. A supervision
note will be sent to the tape operator. Then the copy
process will pause, pending tape library intervention from
the operator. The copy operation will resume as soon as
the requested tape has been loaded in the library, and the
library has been synchronized.

Copy Accessible Files This will start the copy operation for any available files
(Online or Nearline) in your selection. The copy process
will continue until all available files have been copied, and
it will then terminate. The offline files will be ignored, and
no notification will be sent to the tape operator.

Cancel Aborts the copy operation. No files will be copied, even if
some of the selected files may have been available.

Select one of the options by clicking on the corresponding button. If you select Continue
and Wait, the Required tapes dialog will be displayed, giving options for which tape(s) to be
loaded and which tape pools to be used.

Figure 3.7. Offline files – Required tapes dialog

If the selected offline files only exist on one tape, this dialog will only be for information since
there will be no choice from where to copy the data. If the files are located on more than one
tape and in more than one tape pool, you can choose which tape and pool to use. This is for
example useful if there are two copies of a tape, but only one of them is on site. Then you
would want to choose the tape which is stored locally and available to an operator.

By default, all the tape pools the files belong to are selected under Advanced options. If
there is more than one, you will be able to choose between tapes from these pools in the
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drop-down list under Required tapes. Once you have chosen a tape option, the name(s) of
the tape(s) that need to be loaded are displayed in the list:

Figure 3.8. Offline files – List of required tapes

Click on OK to proceed with the operation. The copy progress dialog is displayed, stating
that the system is waiting for the operator to load the required tape.

Figure 3.9. Waiting for Offline Files

Supervision Note to tape operator

When you choose to copy offline files, a supervision note will be displayed in the Active Circle
Administration Tool as well as be sent to the person(s) subscribing to tape notes. The note
will inform the operator to load a tape:

Request for data retrieval from offline tapes
A retrieval request from user <username> requires that the following tapes be put in online
state
This is followed by information about the tape's bar code, the tape pool it belongs to, and
other necessary data.

The copy progress status and completion information for offline files is identical to that of
other files, and is described in the next section.

Copy Progress and Completion
A dialog opens to show the progress of the file copy process. When the transfer is completed,
the progress dialog will display the number of files successfully transferred, the amount of
data copied, and the number of errors encountered. If not all files were copied, an additional
information message will be displayed to remind you to check the list of Not Copied Files
(this list will contain all the skipped files if you selected Skip files above). If multiple files were
processed, you can click on the Details button to view which files were successfully copied,
which files were not copied, which files were overwritten and any off-line files (for example,
archived but not currently available).
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Figure 3.10. Copy Progress/Completion

When you have finished, click the Close button to close the status window.

Deleting Files

It is possible to delete files on Active Circle shares through the File Explorer. Deleting a file
through the File Explorer removes all its versions and purges the file from the system. This
delete function will not affect any local data copies you might have.

Warning

When you delete a file through the Active Circle File Explorer it is definitive. You
will not be able to restore it later.

To delete a file, right-click on it and select Delete.
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Figure 3.11. Delete a file

A dialog box asks you to confirm the action:

Figure 3.12. Confirmation

Click Yes to confirm and continue, or click No to cancel the deletion.

When you click Yes a final warning message appears:

Figure 3.13. Warning

Clicking Yes here will permanently delete the file. Click No to cancel the deletion.

Tip

You can also delete a file permanetly through the same process as above by
selecting it and then pressing the Delete key on your computer's keyboard.
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Deleting Disk Copies
You can delete the disk storage packs that contain the data for a file. If the file data have
been archived to a TAR file on a tape, you may decide that you no longer want a copy of
the file(s) on disk. This is a useful feature for freeing up space in the disk pools. To verify if
there is an archive copy of the pack(s) for a particular file, use the procedure described in
checking the data location.

To delete the packs, right-click on the file, select Data Management and select Remove
Disk Copies from the submenu. A confirmation message will be displayed:

Figure 3.14. Delete Confirmation

Click Yes if you want to continue with the operation. After the delete process has started, an
information message is displayed to inform you of the progress:

Figure 3.15. Delete Process Information

If you click on Close before the delete process has completed, an information message is
displayed to inform you of the ID number of the process, and how you can check the status
of it:

Figure 3.16. Delete Process Information
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To check the status, type this command on the command line of the Active Circle node
indicated in the message:

acfileop --deletePack --show -p x -C nodename

where x is the process number displayed by the information message.

Creating Disk Copies
You can can create new disk packs for files residing in the Active Circle system. This
functionality is provided to enable copying files from tapes to disk. To verify if there is an
archive or disk copy of a particular file, use the procedure described in checking the data
location.

Note

The system can only create a file copy on disk if a storage policy is currently
associated with the share. The file copy will be created in the disk pool specified
by the storage policy.

To create the copy, right-click on the file, select Data Management and select Create Disk
Copies from the submenu. A confirmation message will be displayed:

Figure 3.17. Copy Confirmation

Click Yes if you want to continue with the operation. After the pack creation process has
started, an information message is displayed to inform you of the progress and if the operation
was successfully completed. Click on Details to expand the window to see more information:

Figure 3.18. Create Process Information
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If you click on Close before the process has completed, an information message is displayed
to inform you of the ID number of the process, and how you can check the status of it:

Figure 3.19. Create Process Information

Copy to the Cache

You can copy a selection of files stored on slow media like tapes to the cache area of an
Active Circle node. This functionality is also called destaging. The copying will be performed
in an optimized way according the location of the files on the tape(s). When the user has a
need for bringing files located on a tape on-line, launching this operation in anticipation of
this can save a considerable amount of time. Once the files are in the cache, access to them
will be the at the quickest level possible.

Note

You must have administrator rights to access this functionality.

To copy the selected files to the cache, right-click on the file or directory object(s), select
Data Management and select Copy to the Cache from the submenu.

A confirmation message will be displayed. Click on "Yes" if you want to proceed with the
operation.

Click Yes if you want to continue with the operation. After the destaging process has started,
an information message is displayed to inform you of the progress and if the operation was
successfully completed. Click on Details to expand the window to see more information:
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Figure 3.20. Destaging Process Information

If you click on Close before the copying process has completed, an information message is
displayed to inform you of the ID number of the process, and how you can check the status
of it using the Active Circle command line interface:

Figure 3.21. Copy Process Information

This is an example of the command line status information for a destaging process that was
successfully completed on the share "test":

# acdestage --show -p 2

Please enter the value of 'nodeName':  node-01

2       Copy to the cache from Explorer test    TERMINATED      NORMALLY

The Active Circle acdestage command offers more options for monitoring and managing the
operations (like stopping the process and filtering by file state) for this feature. Please see
the Active Circle Command Line Guide for more information.
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Compute MD5 Checksum
You can compute checksums for one or more files. This involves creating a signature for
each file using the MD5 algorithm. Files without a signature will have an initial signature
created for them. Existing signatures will be realculated and compared to the initial signature.
To compute checksums, select one or more files, right click on the selection and click on
Compute MD5 Checksum:

Figure 3.22. Compute MD5 Checksum menuitem

An information message will be displayed:

Figure 3.23. Compute MD5 Checksum Information

Click on OK to perform the checksum calculations.

If you want to see checksum information for a file, select the file or the directory the file is in,
and the detailed file information will be displayed in the information pane to the right. Scroll
to the right in the file information table if you don't see the checksum columns, which are:

• MD5 Signature

• MD5 Validation

• MD5 Last Validation

• MD5 External Validation (not shown by default)

If no information is displayed in the MD5 columns for the files you computed checksums on,
press the F5 key to refresh the display.
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Figure 3.24. File Checksum Information

If the MD5 data columns are not displayed in the file information table, select the file or folder
in the navigation pane and click on the Select Columns button under Directory Contents
and select the MD5 check boxes. See “Select Columns” for more information about selecting
columns to display.
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Chapter 4. Managing File Versions
If version management has been activated for a given Active Circle Share, then whenever a
user makes a change to a file on that Share — whether it be to the file contents or to one of its
attributes — and then saves those changes, a new version of the file is created in the system.

Any user who has access to the File Explorer and who has the Active Circle access right
History for a given file can restore an earlier version of a file or recover it if it has been deleted.

Note

Unlike CIFS, NFS is state-less, therefore the concept of "saving" does not apply.
The creation of a new version occurs automatically after a period of inactivity on
the file.

Version Search

Tip

If the Version Search Criteria box is not shown at the top of the File Explorer
interface, you can display it by selecting Version Search on the View menu.

Figure 4.1. Version Search Criteria

Using the Active Circle File Explorer you can browse through the history of a Share in order
to locate a previous version of a file or a deleted file. There are several ways of doing this:

• The default view. This view shows you the most recent recent versions of each file
in the system.

• Showing all versions

• Viewing the past

Showing all versions
When used in combination with the Present radio button, the filter option Show all versions
in preceding n hour(s) / day(s) / week(s) / month(s) / year(s) allows you to view all the file
versions for which there has been activity within the selected time period.

To search through a time period, in the Version Search Criteria area, check the box for
Show all versions in preceding, select the time unit (e.g., 1 day), and then click Apply.
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Viewing the Past
This option allows you to view all the file versions that had been created up to and including
the selected date and time.

Click on the Past radio button and then click the Modify button. The following dialog box
appears:

Figure 4.2. Searching for past versions

Select the date and time for your filter. The file versions that existed in the system at that
date and time appear in the File Explorer window.

You can also combine the two methods described above.

Regardless of how you filter the view, files that were present during the selected time periods
but which have since been deleted are shown with a transparent icon with a diagonal bar.
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Figure 4.3. Searching for past and current versions

Restoring Files and Folders

The Active Circle File Explorer restore feature allows you to restore earlier versions of files,
including files that have been deleted by users, whether accidentally or on purpose. When
you restore a deleted file, Active Circle copies the version of the deleted file that you specify
(or the most recent if you just select the file) and creates a new version of the file from it. This
file version will then become visible to the users through the standard file system access.

Tip

Deleted files are only visible when you choose to display them using the Show
all versions in preceding... option (see “Showing all versions” for more
information).

Restore a File Version
To restore an older version of a file on a Share, browse to and select the file in the navigation
pane of the Active Circle File Explorer. The list of all the current versions will then appear in
the right-hand pane. This is also valid for a deleted file that has older versions.
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Figure 4.4. Select the version to restore

Right-click on the version of the file you wish to restore and select Restore File. A new
version of the file is created with the contents of the selected file version.

Restore a Folder Version
You can also restore earlier versions of folders. To restore an older version of a folder, browse
to and select the folder in the navigation pane of the Active Circle File Explorer. The list of
all the current versions will then appear in the lower part of the information pane. This is also
valid for a deleted folder that has older versions. Right-click on the folder to restore and select
one of the two restore options:

Restore Directory Restore only the selected directory, not its content.
Using this option will not restore any files or sub-
folders that were in the directory when it was deleted.

Recursively Restore Directory Restore the directory and all of its contents.
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Figure 4.5. Select the folder version to restore

Restore Deleted Files
To restore a deleted file, select the file (or files) you want to restore in the left pane of the
application (identified with a transparent icon with a diagonal black bar). Right-click on the
file (or selection of files), and select Restore (File). This will restore the most recent version
of the file(s). If you want to restore a previous version of the deleted file, follow the procedure
above.
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Figure 4.6. Restore a deleted file

Restore Deleted Folders
You can also restore earlier versions of folders that have been deleted. Browse to the folder
in the navigation pane and right-click on the folder to select one of the two restore options:

Restore Directory Restore only the selected directory, not its content. Using
this option will not restore any files or sub-folders that were
in the directory when it was deleted.

Recursive Restore... Restore the directory and all of its contents.

Figure 4.7. Select the folder version to restore

If you select Recursive Restore..., a message will be displayed confirming the time period
to restore from. The time interval that will be searched is the one that has been defined in
the Version Search Criteria box at the top of the application window.
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Figure 4.8. Select the folder version to restore

Click OK if you wish to proceed with the restore operation. At the end of the restore process,
a dialog box appears with a summary of the results.

Figure 4.9. Restore process completed

In the restore results dialog, you can click on the Details >> button to see a list of all the
restored files and any files that were not successfully restored.

Note

In this context, a deleted file or folder is a file or folder that has been deleted
from an Active Circle Share using regular user access through for example a
conventional file explorer. A file that has been purged from the system using the
Delete function in the Active Circle File Explorer cannot be restored in this way.
For more information, see “Deleting Files”.
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Chapter 5. File Security
With the File Explorer you can manage user access permissions to the files and folders stored
in Active Circle shares. You can view and modify both the file permissions that are specific
to Active Circle as well as Windows permissions (also called ACLs).

Note

The processes for applying security to files and folders are very similar. This
chapter describes how to apply security to folders, but the same principles apply
to files.

Security Settings

You can access the security options for a folder or file object in either of two ways:

• By right-clicking on the object you want to manage and selecting Security from the
context menu.

• By selecting the object in the right-hand pane of the File Explorer and clicking the
Security button (see below).

Figure 5.1. Folder Security option

The following dialog appears:
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Figure 5.2. Folder security dialog box

From here, you can add or remove users and/or groups to the folder, configure their
basic Active Circle permissions, as well as their Windows-like access permissions (these
permissions also apply if your users are accessing the files from Mac or Linux clients, for
example).

Note

When permissions are being inherited from a parent folder, the checkboxes for
Allow and Deny are greyed out. If you want to modify those permissions, you
must first disable inheritance for the folder.

Active Circle Permissions
There are two permissions that are specific to Active Circle; History and View. These provide
an additional level of rights definitions compared to the Windows permissions.

View This permission can be used to hide files or folders from users. If the View
permission is removed from a file or folder, the user will not be able to see
the object in a directory listing on the share. This will override any Windows
permissions, meaning that the a file will be invisible to the user even if all
rights are granted through the Windows permissions.
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History This permission can be used to prevent restoration of a previous version of a
file or folder. If the History permission is removed, the Restore action will not
work (user will receive an "access denied" message), preventing a previous
version from replacing the current version of the object.

Adding a User or Group

To add a user or group to the current folder, click the Add button. The following dialog box
appears:

Figure 5.3. Adding Users or Groups dialog box

Select the user or group you wish to add and click OK. The new user or group will appear
in the Security dialog box.

Note

It is also possible to add users or groups through the Advanced Settings dialog
box. See “Add User or Group” below.

Advanced Permissions Settings

You can click the Advanced Settings button (see Figure 5.2, “Folder security dialog box”) to
access a more granular level of control over user permissions.
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Figure 5.4. Advanced Settings dialog box

The permissions are grouped by Origin, indicating whether the permission set originates in
Active Circle or Windows.

By default, permissions are inherited in Active Circle. This is indicated by the check marks in
the column labeled Inherited in the settings dialog. If you want to modify permissions, you
must first disable inheritance.

The Apply To column indicates how permissions are to be propagated. The default setting
is "This directory, the subdirectories and files", meaning all contents of the object and all its
children.

Disable Inheritance
You can deactivate inheritance for a folder or file in Active Circle using the Advanced
Permissions Parameters dialog. This is necessary if you wish to modify permissions for
any folder level below the share itself, and you want to protect the modified permissions from
being changed when permissions on the parent folder are modified.

To do this, select the folder you want to protect or modify permissions for, select Security
from the right-click menu, and then click on the Advanced Settings button in the general
settings dialog. The Advanced Permissions Parameters dialog box will be displayed. By
default, the check box next to the option Inherit from parent the permission entries... will
be checked, indicating that inheritance is enabled. Uncheck this box:

Figure 5.5. Disabling inheritance
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An information message will be displayed, asking you to confirm that you no longer want
permission entries from the parent object to be inherited by this object. Select the appropriate
response:

• OK – Copy the permissions from the parent object and apply them specifically to this
object. Future changes to the permissions at the parent level will not be applied to
this object.

• Cancel – Cancel the action without disabling inheritance.

Modify Advanced Permissions
You can make changes to the permissions by selecting the line that corresponds to the user
or group and the origin of the permissions and then clicking the Modify button. Depending on
the origin of the permissions, the Permissions Entry dialog box for either the Active Circle
permissions or the Windows permissions will be be displayed. Note that all the settings in
the advanced permissions dialogs will be greyed out unless you have disabled inheritance
for the selected folder or file (see above).

The Active Circle permissions are History and View.

Figure 5.6. Modify advanced Active Circle permissions

The Windows permissions are the same as those one would find when configuring user
access for a share on a Windows server.
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Figure 5.7. Modify advanced Windows permissions

You modify the permissions by clicking to add or remove check marks in the boxes in the
Allow and Deny columns.

To remove all permissions for the selected user, click on the Erase All button. The user will
no longer have these rights on the object.

Apply Permissions
You can use the Permissions Entry dialog to specify where to apply the permissions. The
settings decide which child objects will inherit the permissions and whether they should apply
to only existing or all future objects.

The default setting for inheritance is to apply the permissions to all files and folders in this
directory and any subdirectories. Using the Apply to pull-down menu, you can change which
objects are to inherit the permissions. The choices are:

• This directory only

• This directory, the subdirectories and files (default)

• This directory and subdirectories

• This directory and files

• Subdirectories and files only

• Subdirectories only

• Files only
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Figure 5.8. Where to apply permissions

By default, the inheritance settings are applied to all future objects of the type selected above.
If you want to only apply the permissions to files or folders that already exist in the specified
locations, check the box at the bottom of the dialog labeled Apply these permissions only
to objects or/and containers included into this container:

Figure 5.9. How the permissions are to be applied

Add User or Group
It is also possible to add users or groups to a folder using the Add button of the Advanced
Settings dialog. To do so, click the Add button, select the user or group to add and click
OK. The following dialog box appears allowing you to configure advanced permissions for
the newly added user.
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Figure 5.10. Permissions entry for users
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Chapter 6. Archiving Files
There are two archiving features available in the Active Circle File Explorer:

• On-demand Archiving

• Archiving for Export

Note

For all archiving types, only the most recent version of each file or folder will be
included in the archive. Temporary files will be ignored.

On-Demand Archiving

Using the Active Circle File Explorer, it is possible to manually archive one or more files, the
contents of a directory or an entire directory structure. The main differences between this
type of archiving and automatic archiving is that it is available not only to administrators and
that when archiving on-demand, you can choose which files or directories to archive.

The archiving method used is incremental, which means that only the files (or the versions
of files) that have not yet been archived will be included. The system will process the list
of files and directories you select to identify which files have changed since the last archive
operation (automatically scheduled or manual). If some of the files you select have already
been archived with their latest version, they will not be included in the archive.

Prerequisites for access to the functionality
The option for creating an archive through the Active Circle File Explorer will not be visible
if this type of archiving has been disabled by the administrator using the circle property
archive.enableOnDemand in the Administration Tool interface.

The share you want to archive from, must be associated with an Archiving Policy that contains
at least one standard archiving constraint. If you want to archive to the cloud, the archiving
policy of the share must be associated with a Cloud Pool. For more information, see the
Active Circle Administration Guide or contact your Active Circle administrator.

The Archive... menu item will be greyed out if your user profile has not been granted the
right to create an archive on the selected share.

Creating an On-Demand Archive
To begin an on-demand archive operation, select the files and/or folders you want to archive,
right-click on the selection, and select Archive.
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Figure 6.1. Select files to archive

A dialog box is displayed where you can enter a list of file extensions to exclude from the
archive (for example temporary files), as well as an email address for sending the report of
the outcome of the archiving process with the following information: Status, Name, Creation
Date, Duration, Archived Files Count, and Data Length (the amount of archived data).

Figure 6.2. Enter extensions to exclude (optional)

Note

The list of extensions to exclude must be entered as a comma-separated list
without the dot and with no spaces:

CORRECT: tmp,mp3

INCORRECT: .tmp, .mp3
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Multiple archiving destinations
It is possible to archive to more than one destination tape pool at the same time. The option
for Multi-Archiving will be available if the administrator has defined more than one data
location in the standard constraints of the archiving policy for the share. In this case the On-
demand Archiving Parameters dialog box will contain radio buttons which let you select
either single or multiple archiving. If you select Single Archiving when multiple destinations
are available, the archive will only be written to the first destination that has been defined
in the archiving policy.

Figure 6.3. Select single or multiple archiving

Archiving Progress
The progress dialog allows you to monitor your archive operation. Clicking Close during the
archiving process will only close the dialog box. The archiving will continue to run in the
background until it is finished. In the case of single destination incremental archiving or full
archiving, the progress dialog box will only contain one progress indicator.

Figure 6.4. Archiving progress – Multiple destinations

At the end of the process, the progress dialog indicates the number of files archived out of
the total available. Click Close to finish the operation. If you entered an email address when
launching the archive operation, you can check it for the results.
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Figure 6.5. Archiving progress – Complete

Note

If you are archiving to a cloud destination using an Active Circle Cloud Pool, the
minimum size requirement for the data selected for archiving is 5 GB by default.
If you attempt to archive less data, you will receive an error message stating that
there is not enough data to perform archiving. If you need to change the minimum
size allowed, please contact product support (requires adding and modifying an
Active Circle system property and restarting the node used for archiving).

Archiving for Export

The archiving for export feature has been designed to allow users to archive selected files to a
dedicated Active Circle Export Pool for the purpose of removing these tapes from the library.
This can for example be useful if you need to provide those files to a partner or customer, or
if you need to move tapes between two separate Circles.

When archiving for export, the files are written in TAR format to the destination tape or tapes.
When the archiving is finished, the tapes should be closed (set in a read-only state) and then
moved out of the library.

Important

The Active Circle system does not consider these archives as part of its collection
of archives and does not track their location.

Prerequisites
The option for creating an archive for export through the Active Circle File Explorer is only
visible if this type of archiving has been enabled through the proper Circle Property in the
Administration Tool interface. The menu item will appear greyed out if your user profile has
not been granted the right to create an archive on the selected share, or if no Export Pool
has been created. In addition, the export pool must be activated in an Archiving Policy that
is associated with the share you want to export from. For more information, see the Active
Circle Administration Guide or contact your Active Circle administrator.



Chapter 6. Archiving Files

Explorer Guide 47

Creating an Archive for Export
To create an archive for export, select the file(s) or folder(s) to export, right-click and select
Export.

Figure 6.6. Select the files to export

A dialog box is displayed where you can enter parameters for the export.

Figure 6.7. Export parameters

Extensions to exclude from
export

You can choose to exclude certain types of files from
the archive based on their extensions. The list of
extensions to exclude must be entered as a comma-
separated list without the dot and with no spaces:

CORRECT: tmp,mp3

INCORRECT: .tmp, .mp3

Close tape You can choose to close the tape when the archiving
has been completed. Choosing this option will cause
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Active Circle to close the tape (set it to read only) for
the purpose of removing the tape from the library.

E-mail You can choose to send an e-mail notification of
the end of the archiving process that contains the
following information: Status, Name, Creation Date,
Duration, Archived Files Count, and Data Length
(the amount of archived data). To send an e-mail
notification, check the Send e-mail box and then
select an address from the list.

Click OK to begin the export archiving.

Figure 6.8. Progress dialog box

The progress dialog allows you to monitor your archive operation. Clicking Close during the
archiving process will only close the dialog box. The archive process will continue to run in
the background until it is finished.
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